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About the Author 

n the Insert tab, the galleries include items that are designed to 
coordinate with the overall look of your document. You can 

use these galleries to insert tables, headers, footers, lists, cover pages, 
and other document building blocks. When you create pictures, 
charts, or diagrams, they also coordinate with your current document 
look. You can easily change the formatting of selected text in the 
document text by choosing a look for the selected text from the 
Quick Styles gallery on the Home tab. 

THIS IS LEVEL 3  HEADING  

You can also format text directly by using the other controls on the 
Home tab. Most controls offer a choice of using the look from the 
current theme or using a format that you specify directly. 

To change the overall look of your document, choose new Theme 
elements on the Page Layout tab. To change the looks available in the 
Quick Style gallery, use the Change Current Quick Style Set 
command. Both the Themes gallery and the Quick Styles gallery 
provide reset commands so that you can always restore the look of 
your document to the original contained in your current template. 

O 



About the Author v 
  

 

 

You can also format text directly by using the other controls on the 
Home tab. Most controls offer a choice of using the look from the 
current theme or using a format that you specify directly. To change 
the overall look of your document, choose new Theme elements on 
the Page Layout tab. To change the looks available in the Quick Style 
gallery, use the Change Current Quick Style Set command. 

You can also format text directly by using the other controls on the 
Home tab. Most controls offer a choice of using the look from the 
current theme or using a format that you specify directly. To change 
the overall look of your document, choose new Theme elements on 
the Page Layout tab. To change the looks available in the Quick Style 
gallery, use the Change Current Quick Style Set command. 

You can also format text directly by using the other controls on the 
Home tab. Most controls offer a choice of using the look from the 
current theme or using a format that you specify directly. To change 
the overall look of your document, choose new Theme elements on 
the Page Layout tab. 

You can also format text directly by using the other controls on the 
Home tab. Most controls offer a choice of using the look from the 
current theme or using a format that you specify directly. 
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C H A P T E R  O N E  

 

Introduction 

Before outlining the 6 Steps, let’s look at life’s 
continually changing perspective 

 

Anne Prescott is 56 years old and happily married.  Anne has led an 
active, productive life.  She raised three children, dotes over her four 
beautiful grandchildren, enjoys working, is active in several 
organizations and loves to work out. 

Anne personifies the modern woman.  Her friends continually say 
to her, often with an envious laugh, "Anne, you’re so lucky... what's 
it feel like to have it all?" 
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Yet in the private places of Anne’s hectic life, something is amiss.  
Anne is feeling... older.  60 is approaching.  It doesn't seem that long 
ago that Anne considered 60 to be ancient, a faraway place where 
old people think and do things so differently from Anne’s values 
and perceptions of what is a "good life." 

"I told myself I would never let age define me," thought Anne as she 
found herself more frequently feeling a bit melancholy, even a little 
anxious, about the future.  Nothing she could put her finger on, but 
just enough to feel uneasy. 

That uneasiness accelerated when, over a few months, some 
significant events brought her age into sharper focus: 

• A snooty little teen queen at the movie theater uttered the 
foulest words in the language as Anne and her husband asked 
for two tickets and heard for the first time…"Is that two 
seniors?" 

• Anne’s doctor told her the aching in her joints was arthritis, 
and gave her a prescription for that drug she saw advertised 
on TV featuring crotchety-looking old people 

• Anne’s husband lost the promotion he was expecting to a 
young hotshot and is increasingly bemoaning all the new 
technology at work he has to learn.  He's worried about 
losing his job at a time he and Anne were starting to get 
excited about retirement planning. 

• Anne’s mother's health is deteriorating, and concerns about 
her ability to live alone are creeping into family discussions 
almost nightly. 
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You get the point  

And it’s not about being 56 or 65… or even 45.  As most of us 
approach or experience the “other side” of 50, our body, our mind 
and the world around us conspire to remind us of our mortality and 
what we have not accomplished.  TV, radio, magazines, the 
newspaper you read – they all seem to be featuring stories about 
Boomers, their challenges and influence. Is it any wonder age 
becomes an increasing focus in our life? 

I believe this focus on age to be counter-productive – to the health 
and well-being, not only of yourself, but also of your family, your 
friends, co-workers, your community and society as a whole.  This is 
big stuff.  This is not about a trendy, feel-good introspection.  This 
shifting focus has serious economic, social and political 
consequences. 

The focus on age in America today is pervasive – from the 18-49 
demographic that is misdirecting focus in the media and making 
media investments dangerously inefficient - to offensive “senior” 
programs that turn off the people they’re supposed to attract (ask 
the AARP how they had to reinvent their marketing) -  to hiring 
and promotion practices in American business that could be 
construed as “profiling.” 

When prime time TV is dominated by commercials for retirement 
planning and drugs to treat aging diseases and erectile dysfunction, 
it’s hard not to have age clouding your radar screen. 

So what do you do about it? 
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That’s what this new book and web portal, EverAgeless.com, will be 
about.  Both will advocate for a different perspective – a focus on 
living an ageless life and achieving a state of mind we’ll call 
“Agelessness.” They will advocate for a proactive, action-focused 
movement toward this state of mind.  Passivity, lethargy and 
resignation are faceless enemies that challenge us as we age. Fear 
erodes confidence.  Disappointments sap the spirit.  Energy wanes. 

And always… always… the mortality freight train keeps picking up 
speed… creating this century’s intense, debilitating pressures to find 
fulfillment FAST – while there is time. This is raw, gut-level, hard-
wired emotional thinking that has defined aging since prehistoric 
man first recognized that younger, stronger hunters were beating 
him to the prey and anxiety about the future began invading his 
thinking. 

In today’s media-rich world, pervasive images reminding us of that 
steamrolling train are everywhere – in GQ, Maxim and Victoria 
Secret’s portrayal of the modern man and woman… in movies, TV, 
on cell phones and the Internet, overwhelming us with data and 
images of a different brand of youthfulness than we remember… 
watching, sometimes stupefied, as technology advances at blurring 
speed… coping with oppressive email volume and downloads of 
endless information to a brain that seems to be firing more and 
more in slow motion… 

No wonder we feel the pressure of TIME.   

One of humanity’s core traits is the need to find fulfillment – to 
find meaning and purpose in life beyond existence. It’s the reason 
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communism and dictatorships can never endure.  It’s the reason the 
future of government, education, the economy, indeed the future of 
the world lies in empowering and energizing the individual’s quest 
for fulfillment in his or her life.  

At the risk of sounding too preachy, these 6 Steps are as valid for a 
school, a team, a business or a government as they are for you as an 
individual – because the principles are the same. They represent a 
path to fulfillment, meaning and purpose that energizes life – for 
yourself, your family and friends, co-workers, your company, your 
community, your government, your world. 

Alas, this lofty sermon can be fodder for a lively discussion at 
another time (and, perhaps, another book).  But for now, the focus 
of this book and web portal will be entirely on you – on your 
personal quest for Agelessness and an ageless life. 

As the book and web portal progress, more excerpts will be 
forthcoming.  We will continually broaden and deepen our 
advocacy for the 6 Steps.  Hopefully, these short excerpts presented 
here will stimulate your curiosity to discover more about this 
fulfilling quest. 

We also welcome your feedback and contributions to our research.  
In addition to our request for “Life Story” anecdotes and  
possible products/services to include, we will soon introduce the 
EverAgeless Feedback Forum  to provide an even more 
interactive dialogue as we progress. 
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Here is a short teaser outlining the  

6 Steps To An Ageless Life 
 

1.  Look inward 

In my consulting practice advising companies and organizations on 
how to develop and energize brands, we first discuss how brand is 
all about differentiating.  What is so unique about our client’s 
business or organization that will influence someone to select their 
product, service or point of view -- in the face of competitive claims 
by others? 

What does this have to do with looking inward?  The 
traditional way businesses develop a brand is to look outside the 
business to the perceptions of others – customers, prospective 
customers, etc., and build a brand that fulfills their needs and 
desires. Trouble is, competitors are doing the same research, getting 

“ “I hope you find the Preview of my new book stimulating, 
thought-provoking and inspiring.  Enjoy!” 

Ken Smith 
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similar answers, resulting in so many look-alike brands.  What’s the 
real difference between Best Buy and Circuit City?  Between 
restaurant chains? Between different brands of soap, toothpaste and 
beauty products? 

Our firm, instead, begins every brand development engagement by 
looking inward -  facilitating  a process of looking for uniqueness 
inside the company or organization – unearthing the client’s reason 
for being.  

As individuals, we, too, are often fooled and confused by the 
perceptions of others – how others think we look, dress and speak - 
how others perceive our intelligence, wit, passion, caring, curiosity, 
talent, faith… and, of course, our age. 

That’s why looking inward is Step 1 on your journey to an ageless 
life. Every journey begins at a starting point, a launch point.  Your 
journey begins by understanding yourself, your core values and 
truths that make you “you.” Only then can you build sustainable 
positive growth in your life.   

The book and web portal will offer guidelines for looking inward, 
how to make your own personal assessment and build a personal 
dossier – what you like, want, where you want to go, who you want 
to be, what fulfillment you seek, what challenges and obstacles must 
be addressed. 
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Secrets shared… 
 
I’ll share secrets gleaned from 30+ years of listening, facilitating 
self-discovery, gently pulling away curtains, facades and even 
stone walls to reveal core truths.  These truths must be 
illuminated, however deeply hidden they may be, before moving 
forward.  

 
You’ll learn practical ways to make meditation a part of your life. 
With the pressures and pace of everyday life, quiet meditation is 
one of the most powerful tools for looking inward with clarity. 
You’ll read Life Stories of peers sharing their own self-discovery 
and how meaningful this first step is in achieving the real 
objective – to live an ageless life. 
 
Every quest must have a beginning, a starting point.  Step 1 is the 
starting point on your quest.  You must first understand 
yourself - free from the perceptions and expectations of others 
that color your self-discovery, free from distraction, free from 
limits and exterior worldly pressures. 
 
The path to an ageless life begins here… within you. 
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2. Age defiantly 
 
This is a topic that arouses strong emotions.  At one extreme are 
the grotesque effects of too many plastic surgeries, a caricature of 
youthfulness and a dangerous addiction. 
 
At the opposite extreme is the obese, 60-year-old mother of two 
grown children, depressed with an unfulfilled life and resigned to 
a spiritless future.  Publicly she may profess a confident, 
contented commitment to "age gracefully," comfortable in her 
own skin and disdaining “all that weight loss and anti-aging 
nonsense on TV."  Privately, she aches with self-loathing and 
contempt for her lack of courage and will to do something about 
her weight, her appearance, her life of quiet desperation. 
 
Like politics and religion, passionate, strongly held views can 
energize a healthy zest for life, or polarize into an "us or them" 
discrimination of the "other."  Our faith, beliefs, convictions or 
perceptions are right and others are wrong - relegating the 
"others” to be labeled as less worthy in some way. 
 
Who's right?  Should we all fight defiantly against the 
consequences of aging?  If so, what do we call those who quietly 
or defiantly say, "No?"  Can we tell who these disdainers are -- by 
their appearance, their personality?  What constitutes superiority 
and inferiority?  Who decides? 
 
Pretty heady stuff.  Is there any right answer? Is it possible to age 
defiantly and gracefully at the same time? 
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As stated earlier, this book and web portal will be an advocacy. So 
any wish-washy fence straddling won’t cut it. 
 
As the title of this 2nd Step, and the overriding theme of these 6 
Steps imply, this author advocates for action.  This book and web 
portal will put forth a point of view that an active defiance of 
aging is both healthy and rewarding -- that the passion to look 
and feel youthful need not lead to extreme behavior. 
 
Action is the centerpiece of this advocacy.  The thoughtful 
introspection of Step 1 is as much action as making the 
appointment to see the obesity specialist.  Positive, moving-
forward action at all levels of this journey is the strategy that will 
enable you to reach the goal of an ageless life. 
 
Action is not just about motion.  Action is also a learning 
experience.  It's John Dewey’s famous axiom about education -- 
that you "learn by doing."  The brain in action is constantly 
refining its perceptions, its strategies.  How many times have you 
procrastinated about something, endlessly thought out what you 
would do, felt anxious and uneasy? Then when you finally found 
the courage to get started, the act of doing something energized 
you.  New information and experiences clarified your thinking. 
“Why didn’t I get started earlier?”  
 
In the book and web portal, I’ll address this confounding 
question of how to age defiantly without doing more harm than 
good.  And, at the same time, find serenity and joy in that which 
cannot or should not be changed. 
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Is celebrating a birthday at 60 meaningless, passé, harmful, joyful?  
How can you create a personal environment around you where age 
is immaterial? How do you relate to friends and family around you 
who do not understand what you’re doing, and question your 
“cultish obsession” with Agelessness? 

Action has consequences.  How can you keep passion from evolving 
into obsession? What resources are available to assist you on this 
journey of action? 

 

3. Filter stress 

stress:  n   tension or pressure exerted on something or 
someone 

Notice I did not say eliminate stress. The tension and pressure 
exerted on us, in some cases, can save us from harmful actions, 
stimulate a thoughtful assessment of a situation, sharpen our senses, 
spur us to rise to the occasion, grow stronger, grow smarter, inspire 
courage. 

Despite all admonitions, we cannot eliminate stress, nor should we.  
However, you can develop and refine ways to proactively filter stress 
– to run stressful information, situations and anticipation through a 
well-designed and well-constructed filter that assesses any stressful 
information, situation or anticipation with one primary test – will it 
help or hinder you as you move forward on your journey to an 
ageless life? 
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I’ll show you the construction plans for this powerful and essential 
filter. I’ll suggest how to reorganize the personal environment 
around you to make room for positive input and feelings that can 
mitigate stress - and keep you from losing your way on your 
personal path to an ageless life. 

Stress can be multi-faceted and multi-layered – involving work, 
home, family, finances and much more.  Often stress environments 
are self-imposed.  I’ll help you assess those environments, run them 
through the filter and suggest how they can become environments 
that support and enhance your journey. 

 

4. Forever aspire 

Aspire to what? It isn’t the “what,” but rather the act of aspiring 
that is important.  Ageless and aspiring are linked in an almost 
spiritual embrace.  If I were to pick one of these 6 Steps that most 
embodies the spirit of this journey, it is Step 4. 

Whatever your age, your education, your job, your health, your 
stress level, your financial position, wherever you are in your life… 
aspire.  To aspire is to breathe. To live. It is hardwired into our 
brain.  If we were forever free to aspire, we would do so with 
consistent joy and anticipation. 

So what stops us from following our true nature as humans?  Life.   
From the moment we become aware of the world, the world 
imposes limits, borders, fear, structure, rules. Other people impose 
their perceptions and opinions that color our perspective and 
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challenge our aspirations.  “You’ll never be beautiful.” Or “a public 
speaker.” Or “president.” “Sports aren’t lady-like.” “Why would you 
want to get a college degree at 60?”  

What’s holding you back? Why aren’t you constantly aspiring to 
something?  Aspirations pull us forward.  They can be as small as 
learning how to use your PDA for more than e-mail… lose a few 
pounds… be more adventuresome.  Or they can be bigger 
aspirations to improve your relationship with your daughter… 
change careers… or deepen your faith. 

Fighting your way through the maze of imposed limits, etc. can 
make finding the starting point of your path to an ageless life quite 
difficult. I’ll help you take an objective look at all these limits, 
borders, fears, etc.  

An ageless life is a forever-aspiring life – to the day your last 
breath is taken. No excuses.  Let nothing overpower your true 
nature.  I’ll help you address the difficult challenge of setting goals. 
People agonize so much over goals and never get to the action part.  

Wedo not have to be entirely realistic as long as the incremental 
steps toward the goal are realistic and meaningful.  Often the 
achieving of small steps toward an unrealistic goal reveals that the 
goal may be more realistic and achievable than we thought when the 
journey started.  

Action continuously changes the dynamics and, more often than 
you expect, possibilities spring up seemingly out of nowhere. I’ll 
help you build an environment and achieve a state of mind where 
aspiration is like breathing – free of limits, borders and fears. 
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Keep moving forward…toward something … forever aspiring… 
forever ageless. 

 

5. Take charge 

By now, it should be pretty clear that purposeful action is the 
consistent theme of this advocacy. All of us are challenged in one 
way or another in our quest to move forward on this journey.  

So many barriers, distractions and circumstances conspire to slow 
our progress or stall our journey. Some we can influence, some we 
cannot.  Life-defining changes in our life, intersecting with the 
natural evolution of Life Stages, can dramatically change our 
perspective.  And every time we slow down or stop our journey, 
remember it requires an even greater level of energy to start moving 
again or pick up the speed. 

That’s why everyone needs to build a systematic, internalized, every-
day commitment to keep moving forward.  And the only way to 
achieve this level of control in your life is to take charge. 

’ll show you how to make “proactive” a way of life. How to commit.  
How to take control.  And how to renew your commitment every 
day. 

In no way do I advocate action without thoughtful consideration of 
risk or consequence.  On the contrary, I will show you how to build 
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a Risk/Reward Evaluator that can help you quickly and effectively 
assess actions to ensure they are aligned with your quest.  

But at the core of this quest is a commitment to action – to keep 
moving, aspiring, always learning form experience, always prudent, 
but always proactive. 

An ageless life isn’t confined by the limits, borders or fears of age.  
An ageless life is life in motion. That doesn’t mean frenzy or even 
substantial change. It means moving forward in mind, body and 
spirit – at whatever pace and degree is right for you - toward a point 
where age, or any other defining limit, is immaterial. 

I’ll help you take charge of your life with a level of commitment you 
may not have thought possible before. Agelessness, in the face of all 
of life’s conspiracies to keep you from this goal, requires a will 
strengthened by constant exercise. Consider me your personal 
trainer providing the exercises, proper technique and motivation to 
strengthen your authority over your life, every day. 

 

6. Embrace fun! 

This is all such serious stuff. Giving you a headache is not one of my 
goals. Neither is suggesting that living an ageless life is free from joy, 
laughter, silliness, fancy or reverie.  An ageless life is a full life – full 
of substance, meaning and full of fun! 

This is a cart-and-a-horse thing. It isn’t that having fun will get you 
closer to an ageless life.  Rather an ageless life frees you to have more 
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fun! I would argue that when you feel yourself having a lot more 
fun in your life, you’re already there.  

A life more free of the barriers, borders and fears that numb the fun 
receptors in our brain is a life in which fun is free to flourish.  
Hopefulness replaces anxiety. Energy replaces lethargy.  
Contentment replaces resignation.  And it becomes a geometric 
progression.  The more joyful life feels today, the better it is likely to 
feel tomorrow. 

The pessimist will tell you not to enjoy life too much now, because 
something will happen tomorrow to dampen that joy.  I would 
argue that, for the person living an ageless life, tomorrow is for 
planning, not for worrying.  The timeliness of an ageless life reduces 
those feelings of unease about the future.   

Of course, we all know that tomorrow may bring pain or sorrow. 
The goal is to make tomorrow less material to your enjoyment of 
today. 

I’ll provide some suggestions and tools that will help you learn how 
to more freely embrace fun in your life.  You’ll be amazed and 
thrilled how that attitude radiates to those around you – at home, at 
work, wherever you are.  And how that radiation is returned to you, 
energizing your life even more. 
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In Summary 
 

Everyone involved in this new book and the EverAgeless.com web 
portal is anxious to bring these initiatives to fruition and share our 
message with you. We are committed to making EverAgeless.com 
your most valued resource in your quest for an ageless life. 
 

We will keep you apprised of progress. We also value both your 
input and suggestions on how we can make these initiatives more 
relevant and useful to you. 

This journey to an ageless life is a journey of discovery and 
fulfillment.  We welcome the opportunity to be of assistance. 

 

Thank you. 
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